


Introduction

Drawing with AutoCAD is really just like drawing on a drawing board.
Auto CAD is a suit of CAD software products for 2- and 3-dimensional design and drafting. It is a vector graphics drawing program. It uses primitive entities such as lines, polylines, circles, arcs and text as foundation for more complex objects.
Auto CAD native file format is auto CAD DWG hence every file made in auto CAD should be saved with an extension ‘.dwg’.

1. COORDINATE SYSTEM IN Auto CAD
Everything that you draw in AutoCAD is exact. It will be more accurate than you will ever need it to be. All objects drawn on the screen are placed there based on a simple X,Y co-ordinate system. In AutoCAD this is known as the World Co-ordinate System (WCS). You must understand this to know how to put things where you want them. Below is a diagram showing you how this system works (place your mouse on the diagram for more info). 





In order to work effectively with AutoCAD, you have to work with this system. Until you are comfortable and familiar with it, learning AutoCAD will be more of a chore. My experience in teaching is that the better a student is with co-ordinates, the better CAD draftsperson they will become..

Here is how it works:
AutoCAD uses points to determine where an object is located. There is an origin where it begins counting from. This point is (0,0). Every object is located in relation to the origin. If you were to draw a line straight out to the right from the origin, this would be considered the positive X-axis. If you were to draw a line straight up, this would be the positive Y-axis. The picture above shows a point located at (9,6). This means that the point is 9 units over in the X-axis and 6 units up in the Y-axis. When you are working with points, X always comes first. The other point shown is (-10,-5). This means that the point is 10 units in the negative X-axis (left) and 5 units in the negative Y-axis (down).

A line has two points, a start point and an end point. AutoCAD works with the points to display the line on the screen. Move your cursor over the picture above and you will see line drawn from the absolute points of (-10,-5) to (9,6). Most of the time you will not have an indication of where the origin is. You may need to draw a line from the endpoint of an existing line. To do this you use relative points. These work the same way, but you have to add the @ symbol (shift+2) to tell AutoCAD that this next point is relative from the last point entered.

2. ANGLE MEASUREMENT IN Auto CAD

AutoCAD measures angles in a particular way also. Look at the diagram below and then place your mouse on it to see how this is done. 




When drawing lines at an angle, you have to begin measuring the angle from 0 degrees, which is at the 3 o'clock position. If you drew a line at 90 degrees, it would go straight up. The example above (when you move your mouse over it) shows a line drawn at +300 degrees, or -60 degrees. 

You might not always have an obvious reference point for 0 degrees. Look at the example below and place your mouse on the image to find out angle in question.
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In this example, you are given information about the lines, but not the angle AutoCAD needs to draw the line from the start point. What you are given though, is (a) the knowledge that 0° is at the 3 o'clock position (b) the knowledge that 180° is at the 9 o'clock position and (c) the angle between 180° and the line you want to draw is 150°. With this information, you can figure out what angle you need. Here is a fool-proof way of getting the angle you need:

1.) Start at the 0° position and measure counter-clockwise (+) to 180°.

2.) From 180°, measure clockwise 150°.

3.) Consider that you just went +180-150 and use that as an equation: +180-150=30

4.) Now you can draw your line using polar co-ordinates (discussed below)

3. ENTERING POINTS IN Auto CAD

You can enter points directly on the command line using three different systems. The one you use will depend on which is more applicable for the situation. The first assignment will get you used to this. The three systems are as follows: 

ABSOLUTE CO-ORDINATES - Using this method, you enter the points as they relate to the origin of the WCS. To enter a point just enter in the exact point as X,Y.
RELATIVE CO-ORDINATES - This allows you to enter points in relation to the first point you have entered. After you've entered one point, the next would be entered as @X,Y. This means that AutoCAD will draw a line from the first point to another point X units over and Y units up relative to the previous point.

POLAR CO-ORDINATES - You would use this system if you know that you want to draw a line a certain distance at a particular angle. You would enter this as @D<A. In this case, D is the distance and A is the angle. Example: @10<90 will draw a line 10 units straight up from the first point.

The three ways of entering co-ordinates shown above are the ONLY way AutoCAD accepts input. First decide which style you need to use, and then enter as shown. Remember that X is always before Y (alphabetical). Don't forget the '@' symbol when you are entering relative points. Any typing error or omission will give you results you don't want. If you make a mistake and need to see what you typed, press F2 to bring up the text screen and check your typing. (press F2 to get back to your drawing.)

4. GENERAL EXPLAINATION OF Auto CAD WINDOW
A) Title Bar - This will show you what program you are running and what the current filename is.

B) Pull-down menus - These are the standard pull-down menus through which you can access almost all commands.

C) Main toolbar - This has most of the standard Windows icons, as well as the most common AutoCAD commands.

D) Property toolbar - This toolbar gives a way to quickly modify an object's properties, such as layer and linetype.

E) Floating toolbar - This is a toolbar that can be moved around the screen, or 'docked' as the main toolbar is.

F) Drawing space - This is where you draw. You have an almost infinite area to draw and this is just a 'section' of the entire space.

G) Scrollbars - These work like in other windows programs. You can also use the PAN command to move around your drawing.

H) WCS Icon - This is here to show you which direction positive X and positive Y go. The W means you're in the World Co-ordinate System. (It can be changed to a User Co-ordinate System.)

I) Status Bar Tray Icons - These icons give you updates on items like reference files program updates and print status.

J) Command line - When you type a command, you will see it here. AutoCAD uses this space to 'prompt' you for information. It will give you a lot of information and tell you where you are in the command. Watch this line while learning.
K) Status bar - This allows to see and change different modes of drawing such as Ortho, Osnaps, Grid, Otrack, etc.

5. BASIC Auto CAD TERMINOLOGY

	Absolute co-ordinates 
	A way of inputting points based on AutoCAD's origin. 

	Acad.dwt 
	This is the default template that automatically loads whenever you start a drawing session. It can be customized to suit your needs. 

	Associated Dimensioning 
	Dimensions that are associated with specific points will update as that point is moved. 

	Backup file 
	AutoCAD can be set to automatically backup your drawing and save it. This is a safeguard in case your file gets corrupted. It is saved with a .BAK extension 

	Block 
	A pre-drawn image you can insert in your drawing to save time and make your file size smaller. 

	Crosshairs 
	This is your cursor when it is in the drawing space. 

	Cursor 
	Your cursor will change depending on where it is in the program. 

	Database 
	An AutoCAD drawing file is actually one large database containing all the information needed to reproduce the objects when the file is opened. Info for layers and linetypes, etc are stored in this manner. 

	Dialog box 
	AutoCAD uses a large number of dialog boxes to get information from you. You must know how input the information that it asks for. 

	Drawing template file 
	This is a file that contains preset values for frequently used settings. AKA a prototype drawing. The file extension is DWT. 

	Extents 
	The outer boundaries of the objects you have drawn. 

	Grid 
	This is pattern of dots displayed on the screen to guide you. It can be toggled on and off by pressing the F7 key. 

	Grips 
	Small 'handles' on objects that allow for quick editing. 

	Layer 
	All objects are drawn on a layer. You can group objects (such as electrical) on a single layer and organize your drawing. 

	Layout Tabs 
	A space used for plotting your drawings (formerly called Paper Space). 

	Limits (Grid) 
	A setting to impose an 'artificial' boundary on your drawing that sets the area of the grid, and when turned on, limits you to drawing in the grid area. 

	Linetype 
	All objects are drawn with a particular linetype. Examples would be solid, center, dashed, etc. 

	Model space 
	The drawing space where you 'model' the objects. 

	Modify 
	A generic term used for changing your objects 

	Object 
	Any item that is in the AutoCAD database. Also known as an entity. 

	Origin 
	The (0,0) point of your current co-ordinate system. 

	Ortho mode 
	This is a drawing mode that allows you to draw only perpendicular lines. It is toggled on and off by pressing the F8 key. 

	Osnap - Object Snap 
	This is a method of 'snapping' to certain, precise points on an object. 

	Path 
	The specific folder where AutoCAD looks for, or saves files. 

	Pick 
	To select an object by 'left-clicking' on it. 

	Plot 
	Also known as print. To make a hard copy of your drawing. 

	Polar co-ordinates 
	A way of inputting points based on distance and angle. 

	Property 
	Any specific characteristic of an object such as layer, scale, linetype, start point, etc. 

	Relative co-ordinates 
	A way of inputting points based on a starting point. 

	Selection set 
	The current group of objects selected for modifying. 

	Snap 
	This is a drawing mode that allows you to snap your cursor to precise points laid out in a grid pattern. Toggle with the F9 key. 

	Styles 
	Formatting that defines the look of text, dimensions, etc. 

	Units 
	The basic drawing unit set for you drawing. For example, you can use inches or millimeters depending on your needs. You can also set the precision you want displayed, such nearest 1/4", 1/2" 1/64", etc. 

	User co-ordinate system (UCS) 
	Modifications made to the World Co-ordinate System (WCS) results in a User Co-ordinate System (UCS) 

	View 
	A particular area of your drawing. 

	View port 
	A separate 'window' on your drawing. You may have more than one viewport visible to see different areas of your drawing at the same time. 

	Wizard 
	An easy step-by-step instruction set to help you set-up certain aspects of your drawing. 

	World Co-ordinate System (WCS) 
	This is the common X-Y co-ordinate system that is the default. If it is modified, it becomes a User co-ordinate System (UCS) 

	Zoom 
	To view either a smaller section of your drawing (zoom in) or a larger section (zoom out) 


6. VARIOUS COMMANDS OF Auto CAD
AutoCAD allows you to have access to a large number of commands. Commands in Auto CAD can be divided into the following sections:

1. Starting commands

2. Drawing commands

3. Editing commands

4. Dimensioning commands 

5. 3-D commands
6. Layering

DETAILS OF EACH SECTION OF COMMANDS




STARTING COMMANDS

1. UNIT CONTROL

When you start the Units command, the first thing you see is the Drawing Units dialogue box, shown on the right. The dialogue box is divided into four main sections. The upper two are "Length", which refers to linear units and "Angles", referring to angular units. Settings for linear units and angular units can be made independently and in each case, you can control both the type and precision. In addition, the Angles section also allows you to specify the direction in which angles are measured.
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Option 



         syntax 

a) 
Toolbar 


                      NONE

b)
Keyboard



          UNITS


· LINEAR UNITS

You can see from the dialogue box that there are five different linear unit types for you to choose from, one of which is "Decimal", the default. The table below shows the effect of the different unit settings on two drawing unit values to give you an idea how the various settings might be used along with a brief description.

	Unit Type
	1.5 Drawing Units
	1500 Drawing Units
	Description

	Decimal
	1.5000
	1500.0000
	Metric or SI units

	Scientific
	1.5000E+00
	1.5000E+03
	Decimal value raised to a power

	Engineering
	0'-1.5000"
	125'-0.0000"
	Feet and decimal inches

	Architectural
	0'-1 1/2"
	125'-0"
	Feet and fractional inches

	Fractional
	1 1/2
	1500
	Whole numbers and fractions


Notice that when you change the unit type, the co-ordinate display on the status bar changes to show co-ordinates using the current unit type. Changing the unit type also affects the way distances, areas and volumes are reported when using the appropriate inquiry command.

For the most part you should not need to change the unit type. Units such as "Architectural" and "Engineering" are there mainly for AutoCAD users in the USA where Feet and Inches are still in common use.

· ANGULAR UNITS
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Looking at the Drawing Units dialogue box again, you will notice that there are also five angular unit types. The default is decimal degrees, but there are other options. The table below shows the effect of the different unit types on two angular unit values. As with the linear units, there are not many circumstances under which you would want to use anything other than the default.

	Unit Type
	12.5 Angular Units
	180 Angular Units
	Description

	Decimal Degrees
	12.500
	180.000
	Metric units

	Deg/Min/Sec
	12d30'0"
	180d0'0"
	Degrees, Minutes and Seconds

	Grads
	13.889g
	200.000g
	400 grads = 360 degrees

	Radians
	0.218r
	3.142r
	2 Pi radians = 360 degrees

	Surveyor
	N 77d30'0" E
	W
	Compass bearings


AutoCAD also allows you to control the direction in which angular units are measured and the position of the start angle. By default, AutoCAD starts with the zero angle at the 3 o'clock position (East) with angles increasing in an anti-clockwise direction. For the most part this does not present any problems once you get used to the idea. However, there are specific situations where it may be desirable to have the zero angle at the 12 o'clock position (North) and angles increasing in a clockwise direction. For example, if you are working on a surveyors drawing or a map base, this latter situation enables you to specify angles with respect to North. To change the direction of angular measurement, use the Clockwise check box in the Angle section of the Drawing Units dialogue box. When this box is checked, positive angles are measured in a clockwise direction, when it is not checked (the default), positive angles are measured in an anti-clockwise direction.

To change the start angle, click on the "Direction…" button in the Drawing Units dialogue box. The Direction Control dialogue box appears. You can set the Base Angle to any of the circle quadrants by clicking on the appropriate radio button or you can set it to a specific angle with the "Other" option. You can enter a specific angle into the edit box or you can pick an angle using the Pick an angle button. The ability to specify an "Other" or user angle can be useful if, for example, your drawing is not oriented to North but where you still want angular measurements to be made with respect to North. To change the direction of angular measurement, simply click on the appropriate [image: image182.png][ Drawingunits ]
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radio button.

· UNIT PRECISION

To change the precision with which linear and angular values are displayed, simply click the down arrow against the appropriate drop-down list (see illustration on the left) and select the number of decimal places required. The default setting of four decimal places is usually adequate for linear units. It is, however, often necessary to change the precision for angular units. Working in whole degrees does not usually give an adequate level of detail for many drawing functions. However, you do not need to change the precision of either linear or angular units unless you have a specific reason for doing so. Changing the unit precision does not make your drawing more accurate, it just means that the co-ordinate display on the status bar and the results from the various inquiry commands will be displayed with a higher degree of precision. The accuracy of your drawing will be determined by the values you enter for the size of objects when you draw and edit them and by the correct use of the various object snaps and drawing aids.

2. ORTHO MODE

Ortho is short for orthogonal, which means either vertical or horizontal. Like the other options on the status bar, Ortho is not really a command, it is a drawing mode which can either be turned on or off. Ortho mode can be toggled on or off in one of three ways. The quickest way is just to click on the ORTHO button on the status bar. The appearance of the button tells you whether Ortho is currently turned on or turned off. When Ortho is turned on, the ORTHO button appears pressed in. You can see how this appears by looking at the status bar illustration below. In the illustration, Ortho is turned on but Grid and Snap are turned off.

Option 



         syntax 

a) 
Statusbar 


                     [image: image3.png]'ORTHO



 

b)
Keyboard



       ORTHO or F8
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Ortho can also be toggled on and off using the F8 Function key (see Function Keys below for more details). Finally, you can also type ORTHO at the command prompt as in the command sequence below. Using Ortho is the equivalent of using your parallel motion and set square on a drawing board. With Ortho mode turned on you can only draw lines which are either vertical or horizontal. Turn Ortho mode on now and draw some lines to get a feeling for how it works.

Command Sequence

Command: ORTHO
Enter mode [ON/OFF] <OFF>: (type ON or OFF)

Ortho mode is probably the simplest of all the drawing aids, and historically one of the oldest.

3. DRAWING GRID

The drawing grid is a regular pattern of dots displayed on the screen which acts as a visual aid, it is the equivalent of having a sheet of graph paper behind your drawing on a drawing board. You can control the grid spacing, so it can give you a general idea about the size of drawn objects. It can also be used to define the extent of your drawing.

Option 



         syntax 

a) 
Statusbar 


                     [image: image5.png]GRID




b)
Keyboard



       GRID or F7
Although you can use the command line to control the visibility of the grid by using the 
"ON" and "OFF" options this is more easily achieved using the F7 key or, better still, by clicking the GRID button on the status bar. However, the command line does offer some additional options. The Snap option allows you to automatically set the grid spacing to the current snap spacing You can also change the aspect ration of the grid. By default, the X and Y spacing of the Grid are the same, resulting in a regular square matrix of grid points. But you can display a grid with different X and Y spacing by using the "Aspect" option.
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Grid mode and X/Y spacing can also be set using the Drafting Settings dialogue box. You can access grid settings by right-clicking the Grid button on the status bar and selecting Settings… from the menu. You can also do this from the pull-down menu, Tools[image: image8.png]


Drafting Settings… and click on the "Snap and Grid" tab.

4. SNAP MODE

Snap mode takes AutoCAD one step further than the drawing board. With Snap mode turned on AutoCAD only allows you to pick points which lie on a regular grid. The Snap grid is completely independent of the display grid. However, the Grid spacing and Snap spacing are usually set to the same value to avoid confusion. You can force the display grid to conform with the snap grid by setting the display grid spacing to zero. The display grid will then automatically change each time the snap grid is changed. When Snap mode is turned on and the Grid is displayed, the Snap and Grid spacing are the same and the crosshairs will jump from one grid point to another as you move across the screen. This makes it very easy to draw objects which have a regular shape. The Snap command is used to set the snap spacing and to toggle Snap mode
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Option 



         syntax 

a) 
Statusbar 


                     [image: image9.png]SNAP




b)
Keyboard



       SNAP or F9
Command Sequence

Command: SNAP
Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.0000>:
    (enter the required snap spacing in drawing units)

	[image: image10.png]




	Orthographic Projection
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	Isometric Projection


Although you can use the Snap command to turn Snap mode on and off, it is much more efficient to use the F9 function key on the keyboard or to click the SNAP button on the status bar.

The "Aspect" option can be used to vary the horizontal and vertical snap spacing independently.

"Rotate" is used to set the snap grid to any angle.

You can also set the snap style to either Isometric or Standard (the default) using the "Style" option. The Standard style is used for almost all drawing situations including detail drawings in Orthographic Projection. The Isometric style is specifically to aid the creation of drawings in Isometric Projection (see the illustrations on the right).

The "Type" option allows you to set the snap type to either Grid (the default) or to Polar. The Polar option can be used in conjunction with Polar Tracking so that Snap mode snaps along polar tracking angles rather than to the grid.

 
 
 
 
 


 
The grid snap is particularly useful if you need lots of modular objects such as bricks or paviors. In the illustration on the left, the Aspect option is used to set the X and Y snap spacings to the brick dimensions and the Rotate option is used to set the orientation of the bond. Once these settings are made, the bricks can be accurately drawn without any other drawing aids

5. FUNCTION KEYS

Many of the modes described above can be controlled quickly using the keyboard function keys. In most cases this is quicker than using a pull-down or the command line. The function keys are arranged along the top of your keyboard. AutoCAD uses function keys F1 to F11. Their use is described below.

The F1 key on your keyboard brings up the "AutoCAD Help: User Documentation" dialogue box. You can use this dialogue box to search for help on any AutoCAD command or topic. To find help on a command or topic, click on the Index tab and enter a keyword. You will usually be given a list of options in the topics list; select the most appropriate and click the "Display" button to see the item.
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The F2 key is used to toggle (turn on and off) the AutoCAD text window. This is a floating version of the command window which can be resized to suit your requirements. The text window contains the whole command history from the beginning of the drawing session. If you wish, you can scroll back to see which commands you have used. The text window is also useful for viewing the results of commands like LIST which report to the command line on a number of lines which may scroll off the command window and make them difficult to view.
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The F3 toggles running Object Snaps on and off. 

The F4 key on your keyboard toggles tablet mode on and off. This only has an effect if a digitising tablet has been calibrated.

The F5 key cycles through the Isoplanes, this only has an effect if "Isometric Snap/Grid" mode is on. The options are Left, Top and Right. The different options describe the plane in which Ortho mode works. It also affects the orientation of Isocircles drawn with the Ellipse command. The illustration on the right shows a cube with isocircles drawn on the top, left and right faces. Each isocircle was drawn using the corresponding isoplane

The F6 key is a three way toggle which changes the co-ordinate reading in the status bar. By default the status bar shows co-ordinates using the Cartesian system. You can use the F6 key to turn the co-ordinate readout off and to change to the polar system when you are in pick mode.

The F7 key is used to toggle grid mode on and off. When grid mode is on a grid of dots is shown on the screen as a drawing aid. You can set the grid spacing by using "Drafting Settings" from the "Tools" pull-down. The grid points do not necessarily reflect the snap setting, they can be set independently, and however, you can force the grid to reflect the snap setting by giving the grid setting a value of zero.

The F8 key on your keyboard can be used to toggle Ortho (orthogonal) mode on and off. When Ortho mode is on AutoCAD will only allow you to draw either vertical or horizontal lines. You can think of it as being a computer version of the parallel motion on your drawing board. You can see if Ortho mode is on by looking at the status bar. The "ORTHO" button is shown "pushed in" when Ortho is turned on.

The F9 key can be used to toggle Snap mode on and off. Snap makes the crosshairs jump to points on a defined grid. The snap spacing can be set using the "Drafting Settings" dialogue box from the "Tools" pull-down menu. You can also see if Snap mode is on by looking at the status bar.

The F10 key is used to switch polar tracking off and on. Polar Tracking allows you to snap to specific angles and these are user definable. 

The F11 key toggles object snap tracking on and off. 




DRAWING COMMANDS
Draw commands can be started in a number of ways. Command names or short-cuts can be entered at the keyboard; commands can be started from the Draw pull-down menu, shown on the right or from the Draw toolbar. 

The Draw commands can be used to create new objects such as lines and circles. Most AutoCAD drawings are composed purely and simply from these basic components
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TOOLBAR OPTION:

COMMANDS FOR DRAWING

1. DRAWING LINES

Lines are probably the most simple of AutoCAD objects. Using the Line command, a line can be drawn between any two points picked within the drawing area. Lines are usually the first objects you will want to draw when starting a new drawing because they can be used as "construction lines" upon which the rest of your drawing will be based. Never forget that creating drawings with AutoCAD is not so dissimilar from creating drawings on a drawing board. Many of the basic drawing methods are the same.

· The Line Command


Option 



syntax 

a) 
Toolbar 


            [image: image15.png]



b)
Keyboard


          line or L
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With the Line command you can draw a simple line from one point to another. When you pick the first point and move the cross-hairs to the location of the second point you will see a rubber band line which shows you where the line will be drawn when the second point is picked. Line objects have two ends (the first point and the last point). You can continue picking points and AutoCAD will draw a straight line between each picked point and the previous point. Each line segment drawn is a separate object and can be moved or erased as required. To end this command, just hit the [image: image16.png]


key on the keyboard.

Command Sequence at the command prompt

Command: LINE
Specify first point: (pick P1)
Specify next point or [Undo]: (pick P2)
Specify next point or [Undo]: [image: image17.png]


(to end)

You can also draw lines by entering the co-ordinates of their end points at the command prompt rather than picking their position from the screen. This enables you to draw lines that are off screen, should you want to. 

· The Construction Line Command


Option 


syntax 

a) 
Toolbar 
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b)
Keyboard


XLINE or XL

Construction Line command creates a line of infinite length which passes through two picked points. Construction lines are very useful for creating construction frameworks or grids within which to design. They are not normally used as objects in finished drawings, it is usual, therefore, to draw all your construction lines on a separate layer which will be turned off or frozen prior to printing.

Command Sequence

Command: XLINE
Specify a point or [Hor/Ver/Ang/Bisect/Offset]: (pick a point)
Specify through point: (pick a second point)
Specify through point: [image: image19.png]


(to end or pick another point)

You may notice that there are a number of options with this command. For example, the "Hor" and "Ver" options can be used to draw construction lines that are truly horizontal or vertical. In both these cases, only a single pick point is required because the direction of the line is predetermined. To use a command option, simply enter the capitalized part of the option name at the command prompt. Follow the command sequence below to see how you would draw a construction line using the Horizontal option.

Command Sequence

Command: XLINE
Hor/Ver/Ang/Bisect/Offset/<From point>: H[image: image20.png]



Through point: (pick a point to position the line)
Through point: [image: image21.png]


(to end or pick a point for another horizontal line)

· The Ray Command

The Ray command creates a line similar to a construction line except that it extends infinitely in one direction from the first pick point. The direction of the Ray is determined by the position of the second pick point. 


Option 


syntax 

a) 
Toolbar 


[image: image22.png]



b)
Keyboard


RAY

Command Sequence

Command: RAY
Specify start point: (pick the start point)
Specify through point: (pick a second point to determine direction)
Specify through point: [image: image23.png]


(to end or pick another point)

· The POLYLINES

Polylines differ from lines in that they are more complex objects. A single polyline can be composed of a number of straight-line or arc segments. Polylines can also be given line widths to make them appear solid. The illustration below shows a number of polylines to give you an idea of the flexibility of this type of line.

[image: image24.png]



You may be wondering, if Polylines are so useful, why bother using ordinary lines at all? There are a number of answers to this question. The most frequently given answer is that because of their complexity, polylines use up more disk space than the equivalent line. As it is desirable to keep file sizes as small as possible, it is a good idea to use lines rather than polylines unless you have a particular requirement. You will also find, as you work with AutoCAD that lines and polylines are operationally different. Sometimes it is easier to work with polylines for certain tasks and at other times lines are best.

Polyline Command

Option 


syntax 

a) 
Toolbar 

[image: image25.png]-]




b)
Keyboard

PLINE

The Polyline or Pline command is similar to the line command except that the resulting object may be composed of a number of segments which form a single object. In addition to the two ends a polyline is said to have vertices (singular vertex) where intermediate line segments join. In practice the Polyline command works in the same way as the Line command allowing you to pick as many points as you like. Again, just hit [image: image26.png]


to end. As with the Line command, you also have the option to automatically close a polyline end to end. To do this, type C to use the close option instead of hitting [image: image27.png]


. Follow the command sequence below to see how this works. 

Command Sequence

Command: PLINE
Specify start point: (pick P1)
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: (pick P2)
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: (pick P3)
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: (pick P4)
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: (pick P5)
Specify next point or
    [Arc/Close/Halfwidth/Length/Undo/Width]: [image: image28.png]


(or C to close)
Polylines can be edited after they are created to, for example, change their width. You can do this using the PEDIT command, Modify[image: image29.png]


Object[image: image30.png]


Polyline from the pull-down menu.
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2. DRAWING RECTANGLE


Option 



syntax 

a) 
Toolbar 


            [image: image31.png]



b)
Keyboard


           RECTANG or REC

The Rectangle command is used to draw a rectangle whose sides are vertical and horizontal. The position and size of the rectangle are defined by picking two diagonal corners. The rectangle isn't really an AutoCAD object at all. It is, in fact, just a closed [image: image188.png]


polyline which is automatically drawn for you.

Command Sequence

Command: RECTANG
Specify first corner point or
    [Chamfer/Elevation/Fillet/Thickness/Width]: (pick P1)
Specify other corner point or [Dimensions]: (pick P2)

The Rectangle command also has a number of options. Width works in the same way as for the Polyline command. The Chamfer and Fillet options have the same effect as the Chamfer and Fillet commands Elevation and Thickness are 3D options.

Notice that, instead of picking a second point to draw the rectangle, you have the option of entering dimensions. Say you wanted to draw a rectangle 20 drawing units long and 10 drawing units wide. The command sequence would look like this:

Command Sequence

Command: RECTANG
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]:
    (pick a point)
Specify other corner point or [Dimensions]: D
Specify length for rectangles <0.0000>: 20
Specify width for rectangles <0.0000>: 10
Specify other corner point or [Dimensions]: (pick a point to fix the orientation)

3. DRAWING POLYGON


Option 



syntax 

a) 
Toolbar 


            [image: image32.png]



b)
Keyboard


           POLYGON or POL

The Polygon command can be used to draw any regular polygon from 3 sides up to 1024 sides. This command requires four inputs from the user, the number of sides, a pick point for the centre of the polygon, whether you want the polygon inscribed or circumscribed and then a pick point which determines both the radius of this imaginary circle and the orientation of the polygon. The polygon command creates a closed polyline in the shape of the required polygon.

This command also allows you to define the polygon by entering the length of a side using the Edge option. You can also control the size of the polygon by entering an exact radius for the circle. Follow the command sequence below to see how this command works.

Command Sequence

Command: POLYGON
Enter number of sides <4>: 5 [image: image33.png]



Specify center of polygon or [Edge]: (pick P1 or type E to define by edge length)
Enter an option [Inscribed in circle/Circumscribed about circle] <I>: [image: image34.png]



    (to accept the inscribed default or type C for circumscribed) 
Specify radius of circle: (pick P2 or enter exact radius)
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4. DRAWING DONUT


Option 



syntax 

a) 
Toolbar 


            [image: image36.png]



b)
Keyboard


           DONUT or DO

This command draws a solid donut shape. AutoCAD asks you to define the inside diameter i.e. the diameter of the hole and then the outside diameter of the donut. The donut is then drawn in outline and you are asked to pick the centre point in order to position the donut. You can continue picking centre points to draw more donuts or you can hit [image: image37.png]


to end the command. Surprisingly, donuts are constructed from single closed polylines composed of two arc segments which have been given a width. Fortunately AutoCAD works all this out for you, so all you see is a donut.

Command Sequence

Command: DONUT
Specify inside diameter of donut <0.5000>:
    (pick any two points to define a diameter or enter the exact length)
Specify outside diameter of donut <1.0000>:
    (pick any two points to define a diameter or enter the exact length)
Specify center of donut or <exit>: (pick P1)
Specify center of donut or <exit>: [image: image38.png]



    (to end or continue to pick for more doughnuts)

As an alternative to picking two points or entering a value for the diameters, you could just hit [image: image39.png]


to accept the default value. Most AutoCAD commands that require user input have default values. They always appear in triangular brackets like this <default value>.

[image: image189.png]



5. DRAWING CIRCLES


Option 



syntax 

a) 
Toolbar 


            [image: image40.png]



b)
Keyboard


           CIRCLE or C

The Circle command is used to draw circles. There are a number of ways you can define the circle. The default method is to pick the centre point and then to either pick a second point on the circumference of the circle or enter the circle radius at the keyboard.

Command Sequence

Command: CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: (pick P1)
Specify radius of circle or [Diameter] <50.0195>:
    (pick P2 or enter the exact radius)

As you can see from the command prompt above the default options are always indicated in triangular brackets like so <Default> and command options appear within square brackets like so [Option]. Each option is separated by a forward slash like this /. You can choose to use the alternative options by typing them at the prompt. For example, the circle command gives you three extra options to define a circle :

1. 3P which uses any three points on the circumference

2. 2P which uses two points on the circumference to form a diameter.

3. Ttr which stands for Tangent Tangent Radius. Obviously to use this last option you need to have drawn two lines which you can use as tangents to the circle. 

If you want to use the Ttr option, you need only enter "T". 

[image: image190.png]Pl




6. DRAWING ARCS


Option 



syntax 

a) 
Toolbar 


            [image: image41.png]



b)
Keyboard


           ARC or A

The Arc command allows you to draw an arc of a circle. There are numerous ways to define an arc, the default method uses three pick points, a start point, a second point and an end point. Using this method, the drawn arc will start at the first pick point, pass through the second point and end at the third point. Once you have mastered the default method try some of the others. You may, for example need to draw an arc with a specific radius. All of the Arc command options are available from the pull-down menu.

Command Sequence

Command: ARC
Specify start point of arc or [Center]: (pick P1)
Specify second point of arc or [Center/End]: (pick P2)
Specify end point of arc: (pick P3)
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7. DRAWING ELLIPSE


Option 



syntax 

a) 
Toolbar 


            [image: image42.png]



b)
Keyboard


           ELLIPSE or EL

The Ellipse command gives you a number of different creation options. The default option is to pick the two end points of an axis and then a third point to define the eccentricity of the ellipse. After you have mastered the default option, try out the others.

Command Sequence

Command: ELLIPSE
Specify axis endpoint of ellipse or [Arc/Center]: (pick P1)
Specify other endpoint of axis: (pick P2)
Specify distance to other axis or [Rotation]: (pick P3)

The ellipse command can also be used to draw isometric circles. 

[image: image192.png]P
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8. POINTS


Option 



syntax 

a) 
Toolbar 


            [image: image43.png]



b)
Keyboard


           POINT or PO

Points and Point Styles

Points are very simple objects and the process of creating them is also very simple. Points are rarely used as drawing components although there is no reason why they could not be. They are normally used just as drawing aids in a similar way that Construction Lines and Rays are used. For example, points are automatically created when you use the Measure and Divide commands to set out distances along a line. 

When adding points to a drawing it is usually desirable to set the point style first because the default style can be difficult to see.

The point command will insert a point marker in your drawing at a position which you pick in the drawing window or at any co-ordinate location which you enter at the keyboard. The default point style is a simple dot, which is often difficult to see but you can change the point style to something more easily visible or elaborate using the point style dialogue box. Points can be used for "setting out" a drawing in addition to construction lines.

Command: POINT
Current point modes: PDMODE=0 PDSIZE=0.0000
Specify a point: (pick any point) 

Strangely, in Multiple Point mode (the default for the Point button on the Draw toolbar) you will need to use the escape key (Esc) on your keyboard to end the command. The usual right-click or enter doesn't work.

The Point Style Command

	[image: image193.png]Pl
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Toolbar
	none

	Pull-down
	Format[image: image44.png]


Point Style…

	Keyboard
	DDPTYPE


You can start the point style command from the keyboard by typing DDPTYPE or you can start it from the pull-down menu at Format[image: image45.png]


Point Style… The command starts by displaying a dialogue box offering a number of options. 

To change the point style, just pick the picture of the style you want and then click the "OK" button. You will need to use the Regen command, REGEN at the keyboard or View[image: image46.png]


Regen from the pull-down to force any existing points in your drawing to display in the new style. Any new points created after the style has been set will automatically display in the new style.

One interesting aspect of points is that their size can be set to an absolute value or relative to the screen size, expressed as a percentage. The default is for points to display relative to the screen size, which is very useful because it means that points will remain the same size, irrespective of zoom factor. This is particularly convenient when drawings become complex and the drawing process requires a lot of zooming in and out.

EXAMPLES ON DRAWING COMMANDS
1. Making a closed figure using line command -> close option
Command: line

Specify first point: 5,6

Specify next point or [Undo]: 8,6

Specify next point or [Undo]: 8,10

Specify next point or [Close/Undo]: c

[image: image47.png]



2. Making a square using line command (Relative polar co-ordinate system)

Command: line

Specify first point: 3,4

Specify next point or [Undo]: @4<0

Specify next point or [Undo]: @4<90

Specify next point or [Close/Undo]: @4<180

Specify next point or [Close/Undo]: @4<270
OUTPUT
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3. Making a Circle using centre and radius option of circle command.

Command sequence

Command: circle

3P/2P/TTR/<Center point>: 3,4

Diameter/<Radius> <2.0000>: 2
OUTPUT:

[image: image49.png]144/ AutoCAD - [Drawing. dwe] EBX
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4. Making a Circle using ttr option of circle command

Command: circle

3P/2P/TTR/<Center point>: ttr

Enter Tangent spec:
Enter second Tangent spec: Radius <0.5000>: .5
OUTPUT

[image: image50.png]14, AutoCAD - [Drawing. dwe] FEX





5. Making an ellipse with center the length(from center) along x-axis and y-axis
Command: ellipse

Specify axis endpoint of ellipse or [Arc/Center]: c

Specify center of ellipse: 4,5

Specify endpoint of axis: @1<0

Specify distance to other axis or [Rotation]: @4<90
OUTPUT

[image: image51.png]44, AutoCAD - [Drawing, dwg] FEX
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6. Drawing semi-circle using the arc(always drawn in anti-clock wise direction)
Command: arc

Specify start point of arc or [Center]: c

Specify center point of arc: 4,5

Specify start point of arc: 5,5

Specify end point of arc or [Angle/chord Length]: 3,5
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EDITING COMMANDS
For using editing commands first you need to select the object in the figure, which you need to edit. This can be done by object selection.                                                                

1.
OBJECT SELECTION

Before you start to use the AutoCAD Modify commands, you need to know something about selecting objects. All of the Modify commands require that you make one or more object selections.

a)
Selecting objects by picking

You have to do is place your cursor over an object, click the mouse button and the object will be selected. 

When you start editing command such as ERASE, two things happen. First, the cursor changes from the usual crosshairs to the pickbox and second, there will be a "Select objects" prompt on the command line. Both of these cues are to let you know that AutoCAD is expecting you to select one or more objects.

Select objects: 

To select an object, place the pickbox over a part of the object and left-click the mouse. When the object has been picked it is highlighted in a dashed line to show that it is part of the current selection and the command line reports "1 found". You will now see the "Select objects" prompt on the command line again. At this point you can continue adding more objects to the current selection by picking them or you can press [image: image53.png]


or the Space Bar to complete the selection.

	[image: image54.png]



	[image: image55.png]



	[image: image56.png]




	The Crosshairs
	The Pickbox
	Highlighted Object


When you pick one or more objects in response to the "Select objects" prompt, you are effectively creating a selection set. Selection sets are an important concept in AutoCAD because they can be used to great effect, especially when drawings become large or complicated.

b) Selecting objects by using commands

· WINDOW POLYGON SELECTION

The Window Polygon option, invoked by typing WP is similar to the Window option except that you can define an irregular polygon shape within which objects will be selected. As with the Window option, only objects that fall entirely within the polygon will be selected.
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Command Sequence at the command prompt

Command: (start one of the editing commands)
Select objects: WP
First polygon point: (pick first point)
Specify endpoint of line or [Undo]: (pick second point)
Specify endpoint of line or [Undo]: (pick third point)
Specify endpoint of line or [Undo]: (pick another point or [image: image57.png]


to end polygon selection)
Select objects: ([image: image58.png]


 to complete the selection set or add more objects)

A polygon is formed by picking at least three points.

· CROSS POLYGON SELECTION

The Crossing Polygon option can be used in exactly the same way as the Window Polygon option but it has the same selection criteria as the Crossing Window option, i.e. objects will be selected if they fall entirely within or touch the polygon boundary. This option is invoked by typing CP at the "Select objects" prompt.

Note: Lines, polygons and windows drawn using the selection options do not exist as drawing objects. Once the selection has been made they disappear.
· USING PREVIOUS SELECTION

AutoCAD always remembers the last selection set you defined. This is very useful because you may need to make a number of changes using different commands to the same group of objects. In order to re-select the last selection set you can use the Previous option. The previous option is invoked by typing P at the "Select objects" prompt.
· SELECTING ALL OBJECTS

The All option is invoked by typing ALL at the "Select objects" prompt. You can use this option to select all the objects in the current drawing, no picking is required. Objects on Locked or Frozen layers are not selected but objects on layers which are simply turned off are selected.
· WINDOW SELECTION

The Window option is invoked by typing W in response to the "Select objects" prompt. Window allows you to define a rectangle using two points in exactly the same way as the RECTANGLE command. Once the window is defined, all objects which lie entirely within the window will be selected.

	[image: image59.png]
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	The Window selection box is shown
as a rectangle with a solid line
	Only objects entirely within the
window will be selected


Command Sequence

Command: (start one of the Modify commands such as ERASE)
Select objects: W
First corner: (pick first corner)
Specify opposite corner: (pick second corner)
Select objects: (at this point you can either select more objects or [image: image61.png]


to complete the
     selection set and continue with the current command.)
· CROSSING WINDOW SELECTION

The Crossing Window option is invoked by typing C at the "Select objects" prompt and is a variation of the Window command. The command sequence is exactly the same but objects are selected which lie entirely within the window and those which cross the window border.

	[image: image62.png]
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	The Crossing selection box is shown
as a rectangle with a broken line
	Objects within and crossing the
window will be selected


· FENCE SELECTION

The Fence option allows you to draw a multi-segment line, like a Polyline. All objects which cross the fence will be selected. The Fence option is invoked by typing F at the "Select objects" prompt.

Command:
(start one of the Modify commands such as ERASE)

Command Sequence

Select objects: F
First fence point: (pick first point)
Specify endpoint of line or [Undo]: (pick second point)
Specify endpoint of line or [Undo]: (pick another point or [image: image64.png]


to end fence selection)
Select objects: ([image: image65.png]


 to complete the selection set or add more objects)

2. EDITING THE FIGURE BY USING EDITING COMMANDS

i. COPY command

The Copy command can be used to create one or more duplicates of any drawing object or objects, which you have previously created. Copy is a very useful and timesaving command because you can create very complex drawing elements and then simply copy them as many times as you like.

Option 



         syntax 

a) 
Toolbar 


                      [image: image66.png]



b)
Keyboard



       COPY or CP
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Command Sequence

Command: COPY
Select objects: (pick object to copy, P1)
Select objects: [image: image68.png]


(to end selection)
Specify base point or displacement,
    or [Multiple]: (pick P2 or M for multiple copies)
Specify second point of displacement
    or <use first point as displacement>: (pick P3)

The multiple option allows you to create additional copies of the selected object(s) by picking as many new points as you like. To end a multiple copy, just hit the [image: image69.png]


key.

Notice that the "Base point", P2 and the "Second point", P3 do not have to be picked on or near the object. The two points are simply used to indicate the distance and direction of the copied object from the original object
ii. MIRROR command 
The mirror command allows you to mirror selected objects in your drawing by picking them and then defining the position of an imaginary mirror line using two points.

Option 



         syntax 

a) 
Toolbar 


                      [image: image70.png]At




b)
Keyboard



        MIRROR
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Command Sequence

Command: MIRROR
Select objects: (pick object to mirror, P1)
Select objects: [image: image72.png]


(to end selection)
Specify first point of mirror line: (pick P2)
Specify second point of mirror line: (pick P3)
Delete source objects? [Yes/No] <N>: [image: image73.png]


(for No to keep the original object)

Notice that in the command sequence above, pressing the [image: image74.png]


key when asked whether to "Delete source objects?" resulted in a "No" response. This is because "No" is the default option. AutoCAD always shows the default option within triangular brackets, in this case "<N>". Many AutoCAD commands offer default options. They are usually the most commonly used and you need only right-click and select "Enter" from the menu or press [image: image75.png]


on the keyboard to accept them.

iii. OFFSET command
Offset is probably one of the most useful commands for constructing drawings. The Offset command creates a new object parallel to or concentric with a selected object. The new object is drawn at a user defined distance (the offset) from the original and in a direction chosen by the user with a pick point. You can offset lines, arcs, circles, ellipses, 2D polylines, xlines, rays and planar splines.
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Option 



         syntax 

a) 
Toolbar 


                      [image: image77.png]



b)
Keyboard



        OFFSET

Command Sequence

Command: OFFSET
Specify offset distance or [Through] <1.0000>: (specify distance) 
Select object to offset or <exit>: (select object, P1)
Specify point on side to offset: (pick direction, P2)
Select object to offset or <exit>: [image: image78.png]


(to end or select another object to offset)

In the illustration below, a line (cyan) has been offset to the right through a distance "Offset" by picking a point to the right of the original line. The result is a new line (red) to the right of the original.

Circles can be offset inside or outside of themselves to create a new circle, which is concentric (has the same center point) with the original circle. In the illustration, a new circle (red) has been created outside of the original by picking a point outside of the original circle. The radius of the new circle is the offset distance "Offset" plus the radius of the original circle.

In the illustration above, the new objects and original objects are shown in different colors for clarity. In reality, offset objects inherit their object properties from the original object.
iv. ARRAY command
The Array command makes multiple copies of selected objects in a rectangular matrix (columns and rows) or a polar (circular) pattern. This command has been completely transformed in AutoCAD 2000i. It is now completely dialogue box driven with the option to see a preview of the array before it is created. You can also now create rectangular arrays at a user specified angle angle. This constitutes a major improvement in usability.

Option 



         syntax 

a) 
Toolbar 


                      [image: image79.png]



b)
Keyboard



        ARRAY

· RECTANGULAR ARRAY

[image: image195.png]BR




The distance between rows is indicated with the dimension DR and between columns with DC. When creating rectangular arrays it is important to remember that new rows are created above the original object and new columns are created to the right of the original object. The resulting array is, therefore, always created with the original object in the bottom left hand position with respect to the current co-ordinate system
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Now start the Array command. First of all, make sure that the Rectangular Array radio button is selected and that you are looking at the Rectangular Array dialogue box and now follow the steps below:

1. Click the Select objects button. The dialogue box will temporarily disappear enabling you to select the rectangle you just drew. Press the Return button on your keyboard to complete the selection. You are now returned to the dialogue box and the message immediately below the Select Objects button should read "1 objects selected". 

2. Enter the number of rows required in the Rows edit box. For this example, enter the value "3". Notice that the schematic preview on the right hand side of the dialogue box updates to reflect the values you are entering. 

3. Enter the number of columns required in the Columns edit box. Enter the value "2". 

4. Enter the row offset in the Row Offset edit box. This is the distance DR in the illustration above. Note that tis is not the distance between rows. In this example, our rectangle is 10 units high and we will enter a row offset of 15. The result will be a 5 unit gap between rectangles. 

5. Enter the column offset in the Column Offset edit box. The same parameters apply as for the row offset. Enter a value of 25 to give a 5 unit gap between our rectangles. 

6. Click on the Preview button. Once again, the dialogue box disappears and the specified array is temporarily drawn so that we can preview it. We are now offered 3 choices. If the array isn't quite right, click the Modify button to return to the Array dialogue box. If you are happy with the array, click the Accept button, the array will be permanently drawn and the command is ended.

· POLAR ARRAY

The polar array works in a similar way to the rectangular array. The main difference is that rather than specifying the number and offset for rows and columns, you must specify a center point and the total number of objects in the array (including the original object).
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1. Click the Select objects button. The dialogue box will temporarily disappear enabling you to select the rectangle you just drew. Press the Return button on your keyboard to complete the selection. You are now returned to the dialogue box and the message immediately below the Select Objects button should read "1 objects selected". 

2. Specify the center point for the array. This is the point C in the illustration below. You can do this by entering x and y co-ordinates into the appropriate edit boxes if you know what these values should be. However, this is rarely the case and most often you will want to click the Pick Center Point button to pick a point from the drawing area. Pick a point somewhere below the rectangle you have just drawn. 

3. Pick a point somewhere below the rectangle you have just drawn. 

4. Enter a value for the total number of items. For this example, enter the value "6". Notice that once again, the schematic preview updates to reflect the values you have entered. 

5. Make sure that the Rotate items as copied checkbox is checked. 

6. Click on the Preview button. Once again, the dialogue box disappears and the specified array is temporarily drawn so that we can preview it. We are now offered 3 choices. If the array isn't quite right, click the Modify button to return to the Array dialogue box. If you are happy with the array, click the Accept button, the array will be permanently drawn and the command is ended. 

The array you have just drawn should look something like the one illustrated below, left. Take some time to play around with the other options in the Array dialogue box to see what they can do.

[image: image82.png]O





The illustration above shows the results of a polar array using an original rectangle (cyan) copied six times about a centre point C, through an angle of 360 degrees (full circle). The only difference between the array on the left and the one on the right is that the Rotate items as copied checkbox was not checked in the right hand example.

v. MOVE command 

The Move command works in a similar way to the Copy command except that no copy is made, the selected object(s) is simply moved from one location to another.

Option 



         syntax 

a) 
Toolbar 


                      [image: image83.png]



b)
Keyboard



        MOVE or M
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Command Sequence

Command: MOVE
Select objects: (pick object to move, P1)
Select objects: [image: image85.png]


(to end selection)
Specify base point or displacement: (pick P2)
Specify second point of displacement
    or <use first point as displacement>: (pick P3)

Note that as with the Copy command, the two pick points, P2 and P3 are used only to indicate the distance and direction.

vi. ROTATE command

The Rotate command allows an object or objects to be rotated about a point selected by the user. AutoCAD prompts for a second rotation point or an angle which can be typed at the keyboard.

[image: image86.png]



Option 



         syntax 

a) 
Toolbar 


                      [image: image87.png]



b)
Keyboard



ROTATE or RO

Command Sequence

Command: ROTATE
Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0
Select objects: (pick object to rotate, P1)
Select objects: [image: image88.png]


(to end selection)
Specify base point: (pick base point, P2)
Specify rotation angle or [Reference]: (pick second point, P3 or enter angle)

Remember, by default, AutoCAD angles start at 3 o'clock and increase in an anti-clockwise direction. The "ANGDIR" and "ANGBASE" variables remind you of this. If you want to rotate in a clockwise direction you can enter a negative angle by using a minus sign.

Note: You can change the angle direction and the base angle using the Units command, Format[image: image89.png]


Units… from the pull-down menu. Click the "Clockwise" check box to change the direction and click the "Direction…" button to set the base angle.
vii. SCALE command

The Scale command can be used to change the size of an object or group of objects. You are prompted for a pick point about which the selection set will be scaled. Scaling can then be completed by picking a second point (not always easy because it can sometimes be difficult to precisely control the scaling) or by entering a scale factor at the keyboard. For example a scale factor of 2 will double the size of the objects in the selection set and a factor of 0.5 will half them.

Option 



         syntax 

a) 
Toolbar 


                      [image: image90.png]



b)
Keyboard



        SCALE
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Command Sequence

Command: SCALE
Select objects: (pick objects to be scaled, P1)
Select objects: [image: image92.png]


(to end selection)
Specify base point: (pick base point, P2)
Specify scale factor or [Reference]: (pick second point, P3 or enter scale factor)

In the example shown above, the original tree symbol has been enlarged by dynamically scaling it using pick points to determine the change in scale. If you want to scale an object precisely, it is much easier to enter a scale factor using the keyboard.

Note that the position of the new sized tree symbol is determined by the location of the base point. The base point, P2 has been picked to the upper right of the centre of the tree which resulted in the centre of the tree shifting to a lower left position. If the base point had been picked in the centre of the tree symbol, the tree would have remained in the same position. In theory the base point can be any point in the drawing area but for ease of control it is best to choose a known point so that the results are obvious.

viii. STRECH command

The Stretch command can be used to move one or more vertices of an object whilst leaving the rest of the object unchanged. In the example below, a rectangle has been stretched by moving one vertex to create an irregular shape.

Option 



         syntax 

a) 
Toolbar 


                      [image: image93.png]



b)
Keyboard



         STRETCH
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Command Sequence

Command: STRETCH
Select objects to stretch by crossing-window or crossing-polygon...
Select objects: (pick first point of crossing window)
Specify opposite corner: (pick second point of window)
Select objects: [image: image95.png]


(to end selection)
Specify base point or displacement: (pick base point)
Specify second point of displacement: (pick second point)

To select vertices to stretch, you must use a crossing window or polygon

Stretching with Grips


Although the Stretch command can be very useful, it has largely been superseded by the use of "Grips" which allow this sort of modification to be made much more intuitively.
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To stretch an object using grips, simply select the object by clicking on it (you can do this without starting a command). The object becomes highlighted and small square grips appear at each vertex and various snap points, depending upon the object type. Click a grip to activate it and click again to reposition it. When you have completed your modifications, use the Escape key (Esc) at the top left of your keyboard to deselect the object and release grips.

ix. TRIM command


The Trim command can be used to trim a part of an object. In order to trim an object you must draw a second object which forms the "cutting edge". Cutting edges can be lines, xlines, rays, polylines, circles, arcs or ellipses. Blocks and text cannot be trimmed or used as cutting edges. The illustration on the right shows the Trim command in action. The red square and circle have been drawn using the Polygon and Circle commands respectively. In order to trim these objects, a line has been drawn (cyan in the illustration), this forms the cutting edge. The Trim command, unlike most other modify commands requires that two separate object selections are made. The cutting edges are selected first (there can be one or more) and then the objects to be trimmed are selected. In the example above, the line is selected first because it forms the cutting edge and then the square and circle 
are selected.

Option 



         syntax 

a) 
Toolbar 


                      [image: image97.png]



b)
Keyboard



         TRIM or TR
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Command Sequence

Command: TRIM
Current settings: Projection=UCS Edge=None
Select cutting edges ...
Select objects: (select the cutting edge, P1)
Select objects: [image: image98.png]


(to end cutting edge selection)
Select object to trim or shift-select to extend 
    or [Project/Edge/Undo]:(pick the part of the square which you want to trim, P2)
Select object to trim or shift-select to extend 
    or [Project/Edge/Undo]: (pick the circle, P3)
Select object to trim or shift-select to extend 
    or [Project/Edge/Undo]: [image: image99.png]


(to end)

Notice that at each trimming step you are given the option to undo the previous trim. This can be very useful if you inadvertently pick the wrong object.

x. BREAK command

Option 



         syntax 

a) 
Toolbar 
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b)
Keyboard



         BREAK
The Break command enables you to break (remove part of) an object by defining two break points. In the illustration below, a corner of a rectangle has been removed. The Break command can be used with lines, polylines, circles, arcs ellipses, splines, xlines and rays. When you break an object, you can either select the object using the first break point and then pick the second break point, or you can select the object and then pick the two break points. 
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Command Sequence

Command: BREAK
Select objects: (select the object using the first break point, P1)
Specify second break point or [First point]: (pick the second break point, P2)
The section of the object is removed and the command ends.

Sometimes you may want to select the object first and then specify the two break points. If this is the case, use the "First point" option to specify the first break point. By default, AutoCAD assumes that the point used to select the object is the first break point. This is often confusing for new users. 

It may sometimes be necessary to break a line into two without removing any part of it. In this case, simply pick the first and second break points in the same position.

xi. CHAMFER command

Option 



         syntax 

a) 
Toolbar 
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b)
Keyboard



         CHAMFER
The Chamfer command enables you to create a chamfer between any two non-parallel lines as in the illustration below or any two adjacent polyline segments. Usually, the Chamfer command is used to set the chamfer distances before drawing the chamfer. Follow the command sequence below where the chamfer distances are changed to 20 before the chamfer is made.
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Command Sequence

Command: CHAMFER
(TRIM mode) Current chamfer Dist1 = 10.0000, Dist2 = 10.0000
Select first line or [Polyline/Distance/Angle/Trim/Method]: D (to set distances)
Specify first chamfer distance <10.0000>: 20 (enter required distance)
Specify second chamfer distance <20.0000>: [image: image104.png]


(first distance value or enter a different value)
Select first line or [Polyline/Distance/Angle/Trim/Method]: (pick P1)
Select second line: (pick P2)
The chamfer is made and the command ends.

Notice from the command sequence that there are a number of options which can be used to control the way the Chamfer command behaves. The Polyline option can be used to chamfer all vertexes of a polyline simultaneously. The Distance option allows you to specify the two chamfer distances. Angle allows the angle between the first line and the chamfer to be specified. Trim is used to control whether the original lines are trimmed to the chamfer or remain as they are. Finally, Method is used to toggle the command between Distance and Angle mode. When Angle mode is used, the chamfer is defined using one distance and an angle rather than two distances.

xii. FILLET command

Option 



         syntax 

a) 
Toolbar 


                      [image: image105.png]



b)
Keyboard



         FILLET
The Fillet command is a very useful tool which allows you to draw an arc between two intersecting lines or adjacent polyline segments. You first need to use the command to set the required radius and then a second time to select the two lines.
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Command Sequence

Command: FILLET
Current settings: Mode = TRIM, Radius = 10.0000
Select first object or [Polyline/Radius/Trim]: R
Specify fillet radius <10.000>: 25
Select first object or [Polyline/Radius/Trim]: (pick P1)
Select second object : (pick P2)

The Fillet command can also be used to fillet arcs and circles. The "Polyline" option also allows you to fillet all vertices of a polyline with a single command. It's worth experimenting with this command, it can save you lots of time and enables you to construct shapes which otherwise would be quite difficult.

For example, you can easily create the lozenge shape shown on the right from a simple rectangle. Since AutoCAD rectangles are just closed polylines, you can use the Polyline option of the Fillet command to fillet all polyline vertexes simultaneously. Try this for yourself; draw a rectangle and then follow the command sequence below.

Command Sequence

Command: FILLET
Current settings: Mode = TRIM, Radius = 10.0000
Select first object or [Polyline/Radius/Trim]: P
Select 2D polyline: (pick P1)
4 lines were filleted
Tip: Make sure that the radius you specify will fit the objects you select, otherwise the fillet command will not work.




DIMENSIONING COMMANDS

The correct use of AutoCADs dimension tools is the key to producing clear and concise measured drawings. If you just need to quickly find a description of the various dimension commands, click on the appropriate button on the QuickFind toolbar below. 




 HYPERLINK "http://www.cadtutor.net/acad/acadr14/dims/dims.html" \l "aln#aln" 
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AutoCAD provides a whole range of dimensioning tools which can be used to quickly dimension any drawing without the need for measurement. Dimensioning in AutoCAD is automatic; lines, arrows and text are all taken care of by the dimension commands. AutoCAD dimensions are special blocks which can easily be edited or erased as necessary. 

AutoCAD provides lots of control over the way dimensions look. Using a system similar to text styles, dimension styles allow you to design dimensions so that they look just the way you want them to.
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For example, the illustration above shows two different dimension styles. The one on the left is the default style known as STANDARD. If you do not create a style of your own or modify the standard style, all dimensions will look like this. The dimension line has arrow heads and the dimension text is positioned above the line and is drawn using the current text style. The dimension on the right has been drawn using a new style. The arrows have been changed to obliques, the vertical alignment of the text has been centred and the current text style has been changed. 

There are lots of dimension commands which include facilities for indicating tolerances and alternate units dimensioning. However, this tutorial aims to cover the most common commands for general use and constitutes an introduction to dimensioning with AutoCAD. If you would like to learn more about dimensions, refer to the AutoCAD user manual. 

AutoCAD divides dimensions into four main categories:

· Linear

· Radial

· Ordinate 

· Angular

Selecting and working with the dimension commands in AutoCAD R14 is much easier than in previous versions. All commands can be accessed from the keyboard and now most commands are also available from the Dimension pull-down menu and the Dimension toolbar. The Dimension toolbar is particularly useful because it places all the dimension commands a single mouse click away. Since the Dimension toolbar is not displayed by default you will need to enable it from the Toolbars dialogue box. To display the Toolbar dialogue box, select View/Toolbars… from the pull-down or type TOOLBAR at the keyboard. To display the Dimension toolbar, click in the checkbox against "Dimension" in the toolbar list. 
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1. LINEAR DIMENSIONING

As the name suggests the Linear dimension commands are used to dimension along straight lines. There are five linear dimension commands, namely: DIMLINEAR, DIMCONTINUE, DIMBASELINE, DIMALIGNED and DIMROTATED. The DIMLINEAR command is probably the most common dimension command you will use.


Option 



syntax 

a) 
Toolbar 


            [image: image128.png])




b)
Keyboard


          DIMLINEAR
You can use this command to generate horizontal and vertical dimensions.
Creating a linear dimension is easy. All you have to do is start the command, specify the two points between which you want the dimension to be drawn and pick a point to fix the position of the dimension line. Consider the diagram (right) whilst working through the following examples. 

Command Sequence
Command: DIMLINEAR
First extension line origin or press ENTER to select: (pick P1)
Second extension line origin: (pick P2)
Dimension line location (Mtext/Text/Angle/Horizontal/Vertical/Rotated): (pick a point to position the dimension line, you will see the dimension rubber banding) 

You may have noticed that the first prompt asks you to pick the first extension line origin or to press the ENTER key. Pressing the Enter/Return key results in the following prompt: 
Select object to dimension: 

[image: image201.png]


AutoCAD allows you to dimension an object simply by picking it. Try this out. Draw a line or a circle and use this option rather than the two point option to see what happens. 

Dimensions will automatically adjust themselves to accommodate most situations. For example, the illustration on the right shows what happens to a dimension if the gap between the two extension lines is too small for the dimension text.

· The Baseline Dimension Command

Option 



syntax 

a) 
Toolbar 
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b)
Keyboard


          DIMBASELINE
You can use this command to generate a series of dimensions from a single base point. You must already have created the first dimension in the sequence using a command such as DIMLINEAR. The DIMBASELINE command then creates further dimensions in a similar way to the DIMCONTINUE command. All the user has to do is pick points.

Command Sequence
Command: DIMBASELINE
Specify a second extension line origin or (Undo/<Select>): (pick next point)
Specify a second extension line origin or (Undo/<Select>): (pick another or [image: image130.png]


to end)
Select base dimension: ([image: image131.png]
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In the example above, the "35.07" dimension was created using the DIMLINEAR command. The others were created using DIMBASELINE and picking points 1 and 2. 
· The Aligned Dimension Command

Option 



syntax 

a) 
Toolbar 
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b)
Keyboard



DIMALIGNED
You can use this command to generate aligned dimensions. These are dimensions along inclined lines which cannot be dimensioned with the DIMLINEAR dimension command because that command will only give a measured dimension in either a horizontal or vertical direction. However, as you can see from the command sequence below, this command works in exactly the same way. 
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Command Sequence
Command: DIMALIGNED
First extension line origin or press ENTER to select:(pick P1)
Second extension line origin: (pick P2)
Dimension line location (Mtext/Text/Angle): (pick a point) 

The DIMCONTINUE and DIMBASELINE commands can both be used in conjunction with DIMALIGNED dimensions. 


2. RADIAL DIMENSIONING

There are two main radial dimension commands, DIMDIAMETER and DIMRADIUS. Both commands result in a similar looking dimension so AutoCAD automatically inserts a "R" to indicate a radius and the dimension symbol to indicate a dimension. You can get AutoCAD to display the dimension symbol by including "%%c" in any text string. For example, in order to draw the 40mm diameter text as it is shown in the illustration on the right, you would need to type "%%c40mm". You can use this special character with any of the text commands. 

The Diameter and Radius commands are supplemented by the DIMCENTER command which can be used to add a center mark to any circle or arc. The DIMDIAMETER and DIMRADIUS commands do not automatically draw a center mark. By convention it is usual to dimension full circles using a diameter and arcs (partial circles) using radius.

· The Diameter Dimension Command

Option 



syntax 

a) 
Toolbar 
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b)
Keyboard



DIMDIAMETER
You can use the Diameter command to annotate a circle or an arc with a diameter dimension. To achieve this simply start the command, pick a point on the circumference of the circle, pick a second point to determine the length of the leader and then add the dimension text or Return to accept the default. 
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Command Sequence
Command: DIMDIAMETER
Select arc or circle: (pick the circumference P1)
Dimension line location (Mtext/Text/Angle): (move the cursor until you are happy with the text position and then pick to complete the sequence) 
[image: image135.png]




· The Radius Dimension Command

Option 



syntax 

a) 
Toolbar 
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b)
Keyboard



DIMRADIUS
The Radius command is identical to the Diameter command except that the dimension measurement is a radius rather than a dimension and the resulting dimension text is [image: image204.png]


prefixed with a "R" to indicate radius. 

Command Sequence
Command: DIMRADIUS
Select arc or circle: (pick the circumference P2)
Dimension line location (Mtext/Text/Angle): (move the cursor until you are happy with the text position and then pick to complete the sequence) 

Notice that in the illustration above the radius dimension has been positioned inside the circle. Both diameter and radius dimensions can be positioned either inside or outside an arc or circle. 

· The Center Mark Command

Option 



syntax 

a) 
Toolbar 
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b)
Keyboard



DIMCENTER
You can use the Center Mark command to annotate a circle or an arc with a cross at the center. The illustration above shows a center mark added to a circle after a diameter has been drawn. 

Command Sequence
Command: DIMCENTER
Select arc or circle: (Pick the circumference of a circle or arc)
A cross is drawn at the center point. 

3. ANGULAR DIMENSIONING

The Angular command is amazingly flexible and can be used to indicate an angle in almost any situation. Just like the other dimension commands, all parts of the process are rubber banded so you can see the results of your actions before you make the final pick. 


Option 



syntax 

a) 
Toolbar 
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DIMANGULAR
Command Sequence
Command: DIMANGULAR
Select arc, circle, line, or press ENTER: (pick a line)
Second line: (pick another line)
Dimension arc line location (Mtext/Text/Angle): (pick point)
Move the cursor position until you are happy with the result. Notice that you can move the cursor to either side of the lines and the angular dimension will change accordingly. 
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You may have noticed that at the first prompt you are given the option to press ENTER. If you use this option you will be prompted to pick the angle vertex and then the two angle endpoints. This is quite useful if the angle you need to dimension is not defined by physical lines on the drawing. The illustration on the right shows the result of this option. The centre point of circle 1 was picked as the angle vertex and the centre points of circles 2 and 3 were picked for the two angle endpoints. The degree character is automatically inserted for you, however, if you ever need to type it, you can do so by typing "%%d". This is another of AutoCADs special characters. 


4. ORDINATE DIMENSIONING

Ordinate dimensions are not really dimensions at all in that they do not indicate a measurement. Rather they annotate known co-ordinate points. The DIMORDINATE command is used to indicate the X and Y ordinate values at any point.


Option 



syntax 

a) 
Toolbar 
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b)
Keyboard



DIMORDINATE
Command Sequence
Command: DIMORDINATE
Select feature: (pick the point to annotate)
Leader endpoint (Xdatum/Ydatum/Mtext/Text): (pick endpoint or use one of the options)
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In the illustration above, the building corner on the left has been annotated with X and Y ordinates using the default method. The one on the right has a Y ordinate which has been forced to display in a vertical position using the Ydatum option. You could also use the Text or Mtext options to clearly describe the point you are annotating.




Editing Dimensions
The dimension edit commands, DIMEDIT and DIMTEDIT are used primarily to adjust the position of the text part of a dimension. This is usually only necessary if the drawing is quite complex and the dimension would read more clearly if it were in a different position. 
· The Dimension Text Edit Command

Option 



syntax 

a) 
Toolbar 
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b)
Keyboard



DIMTEDIT
[image: image208.png]



The Dimension Text Edit command is used to modify the text position of any single dimension. The command can be used to position the text dynamically (this is the default)or one of the options can be used for a specific type of movement. For example, the dimension shown on the right has been modified by dynamically moving the position of the text and then the text has been rotated using the Angle option. 

Command Sequence
Command: DIMTEDIT
Select dimension: (pick the dimension you want to edit)
Enter text location (Left/Right/Home/Angle): (pick a new position or use an option) 

The results of the four available options are shown in the illustration below.
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The Left option moves the text to a left justified position within the dimension. 

The Right option moves the text to a right justified position within the dimension. 

The Home option returns the text to the home position after it has been modified. 

The Angle option enables the text to be rotated about its center. 


· The Dimension Edit Command

Option 



syntax 

a) 
Toolbar 
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Keyboard



DIMEDIT
The Dimension Edit command can be used to modify and change the text of any number of dimensions. The command could, for example, be used to add a standard prefix or suffix to a number of dimensions. 

Command Sequence
Command: DIMEDIT
Dimension Edit (Home/New/Rotate/Oblique) <Home>: (choose an option)
Select objects: (pick one or more dimensions)
Select objects: (pick more or [image: image209.png]
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end) 

The command sequence will vary depending upon which option has been chosen but the results of the various options are illustrated below.
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The Home option returns dimensions to their home position. 

The New option displays the Multiline Text Editor. The changes you make to the text will be applied to all selected dimensions so it is important not to delete the "<>" marker from the text string. Deleting this marker will remove the values from all selected dimensions. 

The Rotate option can be used to rotate dimension text about its center point. It works in exactly the same way as the Angle option of the DIMTEDIT command except that you can rotate any number of dimensions at once. 

The Oblique option is used to set the dimension lines at an angle. This option can be very useful when you are dimensioning a drawing in isometric projection (see the illustration on the right). In this case the drawing has been dimensioned using the Aligned command and then the oblique angle modified to suit the dimension position. This usually means setting an angle of 30, 330 or 90 degrees depending upon the dimension orientation. If you are creating details in isometric projection make sure you are using the isometric snap/grid option for greater efficiency. For more information on drawing in isometric projection and the use of the isometric snap grid, see the "Drawing Aids" tutorial. 





3 D COMMANDS

Although AutoCAD has a number of commands for creating special 3D objects, a lot can be achieved by changing the properties of basic 2D objects like polylines. Most 2D objects can be given a thickness using the thickness option in the Properties (DDCHPROP) command. Although objects with a thickness can be said to be extruded, this should not be confused with the EXTRUDE command which creates solid extrusions; giving an object thickness produces a surface extrusion. All objects can be given an elevation by moving them in the Z direction using the MOVE command. With a combination of the MOVE and Properties commands you can quickly create simple 3D drawings.

3-D CAD TERMINOLOGY

	2-D 
	A concept of displaying real-world objects on a flat surface showing only height and width. This system uses only the X and Y axes. 

	3-D 
	A way of displaying real-world object in a more natural way by adding depth to the height and width. This system uses the X Y and Z axes. 

	Boolean operations 
	Commands that allow you to add, subtract or intersect solid objects in AutoCAD. 

	Complex surface 
	Generally a curved surface. Examples: car fender, landscape contour. 

	Elevation 
	The difference between an object being at zero on the Z-axis and the height that it is above zero. 

	Extrude
	The extrude command raises the shape of a 2D outline into a 3D solid. For example, a circle would be extruded into a cylinder.

	Face
	The simplest true 3-D surface. 

	Facet 
	A three or four sided polygon that represents a piece (or section) of a 3-D surface.

	Hidden line removal 
	A way of hiding lines that would not be visible if you were viewing the actual object you have drawn in AutoCAD. (Command: HIDE) 

	Isometric Drawing 
	A simple way of achieving a '3-D' appearance using 2-D drawing methods. 

	Plan View 
	Also known as the top view, a plan view looks directly down the WCS Z-axis to the X-Y axis. 

	Primitive 
	A basic solid building block. Examples would be boxes, cones, cylinders. 

	Region 
	A 2-D area consisting of lines, arcs, etc. 

	Rendering 
	A complex way of adding photo-realistic qualities to a 3-D model you have created. 

	Shading
	A quick way of adding color to a 3-D object you have drawn. (Command: SHADE) 

	Solid Model
	A 3-D model creating using solid 'building blocks'. This is the most accurate way of representing real-world objects in CAD. 

	Surface Model 
	A 3-D model defined by surfaces. The surface consists of polygons. (See facets.) 

	Thickness 
	A property of lines and other objects that gives them a 3-D like appearance. 

	UCS 
	The user co-ordinate system. This is defined by the person drawing to have easier access to portions of a 3-D model. 

	View
	A particular view of the object you have created. 

	View port 
	A window into your drawing showing a particular view. You can have several viewports on your screen. Different from the viewports used in plotting. 

	Wire-frame Model 
	A 3-D shape that is defined by lines and curves. A skeletal representation. Hidden line removal is not possible with this model. 

	Z-Axis 
	The third axis that defines the depth. 


As computers and software get more sophisticated, working in 3D becomes more popular. You have more power in desktop machine today, than was dreamed of when CAD first appeared. Be prepared that you will likely need to learn 3D at some point in your career. Once you are comfortable working in 3D, you'll find that you will rarely want to draw in 2D again. Autodesk (the makers of AutoCAD) make other products designed specifically for certain disciplines - Architectural Desktop, Map, 3D Studio Max and more. Depending upon your budget and needs, you may need to look into programs like these. The concepts taught in these lessons will aid you when you work in any 3D program. 
1. DDVPOINT

You can use this command to get an axonometric view of your drawing. 
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Option 



syntax 

a) 
Toolbar 


            None
b)
Keyboard



DDVPOINT
There are a number of ways to get an axonometric view of your AutoCAD drawing but the DDVPOINT command is probably the easiest and quickest to use. It is, however, buried two layers deep in the pull-down menu so it's often quicker simply to type it at the keyboard, since there is no toolbar button. As you probably recognise from the command name it is a dialogue box driven command. The Viewpoint Presets dialogue box is illustrated on the right. As you can see, you define a view by specifying two angles. The first angle is the rotation from the X axis (the horizontal angle). The second is the angle from the XY plane (the vertical angle). Using the dialogue box you can specify an angle either by picking on the two dials or by entering an angle into each of the two angle edit boxes. You can even look at your drawing from underneath by specifying a negative vertical angle. For most purposes a horizontal angle along one of the diagonals, 45, 135, 225 and 315 and a vertical angle of 30 give the best results. You can return to a plan view of your drawing by using the PLAN command. To do this, just enter "PLAN" at the command prompt and then [image: image147.png]


to accept the "Current UCS" default. You can also return to any previous view by using the Zoom Previous command option, Z [image: image148.png]


P [image: image149.png]


at the keyboard or [image: image150.png]


from the Standard toolbar. 
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2.  DDCHPROP 


Option 



syntax 

a) 
Toolbar 


            [image: image152.png]



b)
Keyboard



DDCHPROP 

You can use the DDCHPROP command to change the colour, layer, linetype, linetype scale and thickness of any single or multiple object selection. The DDMODIFY command gives all of these change options in addition to those which are specific to the object type. DDMODIFY is always used by AutoCAD as a default for single object selections when the Properties command is selected from the toolbar or from the pull-[image: image211.png]


down menu. 

Command Sequence
Command: DDCHPROP
Select objects: (pick one or more objects)
Select objects: [image: image153.png]



When you have selected the objects, the Change Properties dialogue box appears. To change the thickness, simply enter a value (in drawing units) in the Thickness edit box. When you click the "OK" button your objects will be extruded by the amount specified. 

The illustration (right) shows the result of applying a thickness to a circle. A circle with no thickness is shown on the left and a circle with thickness on the right. Effectively a circle with thickness becomes a cylinder. You can tell by the orientation of the UCS icon in this illustration that this is an axonometric view (see "The DDVPOINT Command" above for details). 
Moving in the Z Direction
By now you should be quite used to using the Move command but up until now you've only been moving 2D objects in the XY Plane. Move can just as easily be used to move a drawing object vertically, perpendicular to the XY Plane. You can do this by using XY and Z co-ordinates or by picking points in 3D space. 

In the illustration on the left a circle has been moved from the base plane of a cube to the top face of a cube. This is done by using the MOVE command (Modify/Move from the pull-down or [image: image154.png]


from the Modify toolbar). Just start the MOVE command, select the circle, pick one of the lower corners of the cube as the base point (use the end point Osnap!) and then pick the corresponding top corner as the second point, again using the end point Osnap. If you look at the circle in plan there appears to be no difference in it's position because it has not been moved in the XY plane but perpendicular to it. You can use the same principle to move any drawing entity. Bear in mind that you must always use an Osnap when you are picking points in 3D space. If you do not, the picked point will always be on the base plane, which doesn't make any sense. One of the problems with this is that you may not realise your mistake until you change your view position because in the current view the objects will appear to have been moved normally. It's a good idea to keep switching your view point as a check. 

In the above example the move was fairly easy because we had a cube to use as a guide. Very often you will need to move an object vertically without any guide. In such a case you should use co-ordinates. For example, if the cube in the illustration above was 40 drawing units high then I could move the circle using the following command sequence. 

Command Sequence
Command: MOVE
Select objects: (select the circle)
Select objects: [image: image155.png]



Base point or displacement: 0,0,0
Second point of displacement: 0,0,40 

Notice that I use the UCS origin point as a base point, that's because it's standard practice but in principle it could be any point in space. The most important thing is that the X and Y co-ordinates remain the same (because we do not want to move in the XY Plane) and the Z co-ordinate must increase by the distance you want to move up. Using co-ordinate 25,43,16 as the base point and 25,43,56 as the second point would have resulted in exactly the same move. To move down you just need to specify a negative Z co-ordinate. For example to move the circle down by 40 units the second point co-ordinate would be 0,0,-40. 
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3.  3D Face  


Option 



syntax 

a) 
Toolbar 


            [image: image156.png]<z




b)
Keyboard



3DFACE
The 3D Face command is used to draw 3D surfaces with 3 or 4 edges. 

[image: image213.png]


 

Command Sequence
Command: 3DFACE
First Point: (pick point)
Second Point: (pick point)
Third Point: (pick point)
Fourth Point: (pick point or Return for only 3 edges) 
Third Point: (start another 3D Face or Return to end) 

Why do I need a 3D Face? 
The reason is that when you give an entity like a rectangle a thickness it is given solid sides in the direction of the extrusion but it is left open ended like a tube. To add a top and a bottom to a box you must use 3D Faces. In the illustration on the right, two boxes have been shaded using the Shade command, SHADE from the keyboard, View/Shade/Options from the pull-down or [image: image157.png]


from the Render toolbar. See SHADE for a description of the Shade command options. The box on the right is a rectangle which has been given a thickness. As you can see, it does not have a top. A 3D Face has been added to the top of the box on the left which gives the effect of a solid surface when shaded. 

When you use the Shade command, don't forget to use the Regen command to get back to the wireline drawing. AutoCAD does not allow you to pick points on a shaded drawing. 

For complicated shapes you may need to use a number of 3D Faces to fill a surface. Fortunately, extruded circles are automatically given a solid top and bottom so you don't need any 3D Faces. If you do need to use a complex of faces to fill a surface there is a way to hide the join lines between faces. If you type "I" and [image: image158.png]


before the first pick point of any edge, that edge will be made invisible. If you are careful you can easily fill a complicated surface with many 3D Faces which will simply appear as a single continuous surface. If you need to create a very complex surface it may be better to use the EXTRUDE command which creates solid extrusions i.e. they already have top and bottom surfaces.




3D Objects

In addition to the simple 3D objects you can create by giving objects thickness and adding 3D Faces, AutoCAD provides a number of ready made 3D objects. These objects can be chosen from the 3D Objects dialogue box. As you can see from the illustration of the dialogue box below, you can create very simple objects like a box and complex ones like the torus. 
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You must invoke the 3D objects dialogue box from the pull-down menu
Draw/3D Surfaces/3D Objects…, there is no keyboard equivalent. Alternatively you can select individual 3D Object commands from the Surfaces toolbar. Each 3D Object requires different input from the user but the command line is quite explicit so you shouldn't have any problems. 

One of the most useful objects is the Sphere. In the illustration on the right a 3D tree has been created using a circle with thickness as the trunk and a sphere as the canopy. One thing to bear in mind when creating spheres is that the centre of the sphere will be on the ground plane. Therefore, half of the sphere is below ground level and half above. If you want the sphere to sit on the ground plane, all you have to do is move it up through a distance which is the same as it's radius. 

Another consideration when creating spheres and some of the other shapes is the number of segments to use. It is very tempting to use a lot and create a smooth shape but this does take lots of drawing memory so go carefully. The default value (16) is usually adequate for most purposes. 

Command Sequence
Invoke the dialogue box from the pull-down (Draw/3D Surfaces/3D Objects…), pick the sphere icon and then the "OK" button or pick [image: image160.png]


from the Surfaces toolbar. 

Center of sphere: (pick point)
Diameter/<radius>: (pick point or enter value) 
Number of longitudinal segments<16>: (enter number or[image: image161.png]


)
Number of latitudinal segments<16>: (enter number or[image: image162.png]


)
Your Sphere is drawn.





LAYERING

Layers are used to organize drawings. Imagine a large project for a high-rise tower. The designers would create layers for the electrical, plumbing, landscape and more. It is necessary to control the drawing and turn some layers off and view only the ones you want. This is one reason why layers are needed. But if you were to use AutoCAD professionally, every drawing you dealt with would have layers.

creating a layer for the dimensions, one for the lines (objects that were drawn) and another for the text. Start the LAYER command (LA). This will bring up the Layer Properties Manager (shown below). We'll cover the things that are used most often in this lesson. 
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Looking at the Dialog Box, you will see a lot of information. Notice the button beside Make Current on it. Below it is the name of the current layer you are drawing on. The main window gives you information about each particular layer. At this point, you want to be concerned with the 'Name', 'On' (light bulb) and 'Color' (colored square) columns as well as the 'New' button. 

Now you have the dialog box on your screen, click the 'New' button. This will create a new layer and give you an opportunity to name it. Name this layer TEXT. Click on the small box towards the right and select yellow for the color. Create another layer and call this one DIM (for dimensions), and make its color red. Finally, create a third layer and call it OBJECT and make its color green. You have just created three new layers in your drawing. Highlight the TEXT layer and then press the 'Make Current' button. This makes the TEXT layer current and anything you draw will be placed on that layer. Your Dialog box should look like the one above. If it does, press OK to close the dialog box.

More about Layers 
In the Layer Properties Manager, you will notice that each layer can have a number of specific properties. 
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· Status: Displays the current state of the layer. In this example, the green check means that Objects is the current layer.

· Name: The name of the layer. Give layers understandable names.

· On: If a layer is 'On' it means that it is visible (but objects can still be erased when the 'Select > All option is used).

· Freeze: A layer is not visible and cannot be deleted.

· Lock: Layer is visible, but cannot be modified.

· Color: A specific color for everything on that layer.

· Linetype: A specific linetype (hidden, center, etc) for the layer.

· Lineweight: The visible width of the objects on that layer.

· Plot: A defined color for the plotter to use on that layer.

· Plot (yes, two colomns use the same name: Switch on or off if that layer is plotted.

· Description: A user-defined description for the layer. 




SUMMARY OF FEW COMMANDS
	Command
	Keystroke
	Icon
	Menu
	Result

	Rectangle 
	RECTANGLE / 

REC 
	[image: image165.png]



	Draw > Rectangle
	Draws a rectangle after you enter one corner and then the second.

	Multi Lines
	MLINE / ML
	No Icon 
	Draw > 

Multiline 
	Draw parallel lines based on the parameters you define. 

	Trim 
	TRIM / TR 
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	Modify > Trim 
	Trims objects to a selected cutting edge. 

	Extend 
	EXTEND / EX 
	[image: image167.png]



	Modify > Extend 
	Extends objects to a selected boundary edge. 

	Offset 
	OFFSET / O
	[image: image168.png]



	Modify > Offset 
	Offsets an object (parallel) by a set distance. 

	Object Snaps 
	OSNAP / OS / F3 
	CLICK
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	Tools > Object Snap Settings 
	Brings up the OSNAP dialog box. 

	Command 
	Keystroke 
	Icon 
	Menu 
	Result 

	Move 
	Move / M 
	[image: image170.png]



	Modify > Move
	Moves an object or objects

	Copy 
	Copy / CP 
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	Modify > Copy
	Copies object(s) once or multiple times

	Stretch 
	Stretch / S 
	[image: image172.png]



	Modify > Stretch
	Stretches an object after you have selected a portion of it

	Mirror 
	Mirror / MI 
	[image: image173.png]AN




	Modify > Mirror
	Creates a mirror image of an object or selection set

	Command 
	Keystroke 
	Icon 
	Menu 
	Result 

	Move 
	Move / M 
	[image: image174.png]



	Modify > Move
	Moves an object or objects

	Copy 
	Copy / CP 
	[image: image175.png]



	Modify > Copy
	Copies object(s) once or multiple times

	Stretch 
	Stretch / S 
	[image: image176.png]



	Modify > Stretch
	Stretches an object after you have selected a portion of it

	Mirror 
	Mirror / MI 
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	Modify > Mirror
	Creates a mirror image of an object or selection set

	Command
	Keystroke
	Icon 
	Menu
	Result

	Layer 
	Layer / LA 
	[image: image178.png]



	Format > Layer
	Starts the Layer and Linetype property dialog box

	Text 
	Text
	No Icon 
	Draw > Single Line Text
	Creates a single line of text

	Dimension
	Dim
	Many 
	Dimension > (pick one)
	Dimensions previously drawn objects

	Scale
	Scale / SC
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	Modify > Scale
	Proportionately resizes (or scales) objects
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